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 Excel Versions

A o I

I'll be teachlng from the Mlcrosoft 365 versmn of Excel, and notmg any
differences or limitations in the legacy versions of Excel. References to | Home Insert  Page Layout
Excel 2013+, Excel 2016+, and so on mean a feature is available in all o
[ A Cut R
subsequent versnons, mdudmg Mlcrosoft 365 ) : Calibri

' B I U-
The Future of Excel Legacv Vers:ons ¥ Eqrmat Painter
I demonstrate each technique at

least twice, first by way of
numbered steps in PowerPoint,
and then in Excel.

£ WO N

Microsoft 365 Perpetual Licenses

(Formerly Office 365) Pay once for the software to
Subscription-based version of Microsoft || use on a single computer. No
Office, which includes Excel. Use the new features added until you
software on multiple devices, new buy a new license. Includes

calculation engine, eervices and more Excel 2019 Handouts include PDF of today S
fea:cures are rgllmg ogt that will Excel 2016 presentation along with an example

dramatically set this version apart from Excel 2013 workhook that contains most

past Excel versions. Excel 2010 examples I'll teach from as well as
www.microsoft365.com Excel 2007 and earlier related articles.

Email ask@davidringstrom.com if
you haven't received the handouts.
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Duplicating Excel Worksheets

o A w | e y 4 A B | C B
Sﬁle:lt Fon"c‘at on 1 |Interest Rate 5.25% 1 }Interest Rate 5.25%
KREIos sl 2 [Term a8 2 [Term a8
3 |Principal 30,000.00 3 jPrincipaI 30,000.00
4 |Payment ($694.28) 4 |Payment ($694.28)
Sort & Find & 2|t 5 |
Filter - Select ~ Move selected sheets 4§ 6 Payment# Date  Interest Princ
Cell Size To book: 7 1 1 1/1/2018 131.25 5
PI%C RowHeight:. s | T [ |carpaymentaisx s 2 1/2/2018 12879 5
‘ , 2% Before sheet: 9 3 1/3/2018 126.31 5
AutoFit Row Height t
z Car Payment | [f 10| 4 1/4/2018 12383 5
('__J) Column Width,,. (move to end) 11 5 1/
! / Insert..,
AutoFit Calumn Width 12 | 6 1/t
i " S E% Delete
Default Width... 13| W
Visibility Rl Bl 8 1/¢
, A 15 9 1/¢
Hide & Unhide b 1
O ize Sk 4 = 16 | 10 1/K Qi View Code
rganize Sheets oK ) C | 4
> ; . - e I 17 1} 11 1 F Protect Sheet...
Rename Sheet | ,KL I I1Z] 2010 TUSOT JY 18 | 12 1/1: g
: = : 3 Tab Color »
"Move or Copy Sheet... 19 | 19(6 13 1/

¢ The worksheet has

; \ - TR, == =
20 | been duplicated. 20 | "f"Alternative: Right-click

21 | RS || the worksheet tab.
22 | 16 1/4) M9 93.15 64 22 | 5

Tab Color

Protection

=lect All Sheete

— [B7 Protect Sheet... S —— * - ' 2
=8 » CCarPayment (2) | ..D(+)

)

| Car Paiyment |

nckCe

|
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Introduction to Pasting

=

Select cell G1

'Balance

29,436.97
| 28,871.47
| 28,303.51
| 27,733.05

651,26 | 0.00 )}

| Car Payment {+)

:guoooxn‘o-mawm»-a

Insert Page Layout

1 : Interest Rate
2 _;Term
3 |Principal 30,000.00
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Interest R.

525%

Term
Princip
en 94. 28)

7 Bym

A copy of the data has been pasted.

2
35
36
37
38
39
40.
a1
82
43

1/10/2020
1/11/2020
1/12/2020

1/1/2021

1/2/2021

1/3/2021

1/4/2021

1/5/2021

1/6/2021

1/7/2021

A4 .(

4116

38.30

35.43

32.55

29.66
2675

23.83

20.90

17.95

£50.28

653.12
655.98
658.85
661.73
664.62
667.53
67045
673.39
676.33

S N0 1001 AT

-

~

PO S - - )

— <

Optional: press Escape to clear the
clipboard. Excel has a propensity to
clear the clipboard when you carry
out most Excel commands that
don'tinvolve pasting data, which
can mean you may have to select |
and copy itagain. ‘
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Other Paste Options

ZThe Paste Special dialog box offers a variety of
File Home [EBGEES pasting options. You can revisit the Paste
Options dialog box without copying again,
such as to first paste Column Widths, and then
to paste Formulas, Values, and/or Formatting.

A Paste Options
command appears after
each Paste action. = X Cut

1 ER Copy -

lnterest Pnnc:pal Balance \4@ ‘ Format Painter

2 4401  650.28  Paste Paste p Paste Special

hoose Values and Number
Formatting to convert ) - " All using Source theme
formulas to static values . m " Formulas " All except borders
. Paste Values . " Values " Column widths
29.66  664.62 o o wRC R, 2694.28 " Formats " Formulas and number formats
26.75 667.53 123 123 123 123 '23 " Comments " Values and number formats

23.83 —— =+ __Dthor Pacta ('\nﬁnnc Other Paste OpﬁOﬂS a ‘@ Validation " All merging conditional farmat

4 Values & Number Formatting (A) T : -
20.80 ey Ty T T TS ) - Vo d = r:;] /6/202 Operation
17.95 67633 s4s0.51 4 7202 @ None " Multiply
1499 679.29 2,747.01 “/8/202 ¢ agq " Divide
12.02 68226  2,064.75 45 | pactespe C Subtrac

9.03 685.25 1,379.50 | 46| Ypxoprvz
6.04 68325  691.26 1/11/202 | Skip blanks I” Transpose

. ; ; 1/12/202
3.02 69126 0.00 /12/ paste Link | oK Cancel

| Car Payment ‘

1.
1.
1.
1.
1.
1.
1.
1.
1.
1
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Inserting/Deleting Rows/Columns

5.25%
48
30,000.00

A C

(369423

Select rows 1:3. }'tﬁ(eit,, _ Princ
131.25

128.79

2 1/2/2018
3 1/3/2018 126.31
4 1/4/2018 _123.83
| Car Payment ©)

David Ringstrom

* Select Insertfrom the
Home menu.

Filt
Editing

Insert Sheet Columns

Insert Sheet

hfma
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W 00 ~N O v & U

| WEerestRy
Term

New rows have been
inserted. You can insert
columns in the same fashion.

Iternative: Right-click
on your selection.

|Principal
|Payment
Delete

é_Pavment #ﬁ[r)ate
' 1

Clear Contents

u Format Cells...

David Ringstrom

Select Delete from the
Home menu.

Filter ~ Sel
liting
R

aqe Layout

Click Undo (or press Ctrl-Z) if you
change your mind. You can
generally undo your last 100
actions in a workbook, however
certain actions like inserting/
deleting worksheets preempt

your ability to Undo past actions.

> O
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A e A B c
! |Amortization Schedule 1 Amortization Schedule
2| 2
3 | 4 :
Gl NI Be Type Amortization Schedule in cell A1, ‘Cells A1:E1 are now merged into
2 |Term and then select cells A1:E1. a single cell. Merged cells
6 |Principal 30, 05w sometimes solve one problem
7 |Payment (5694.28) and create others, such as
8 | prompts indicating a certain
9 |Payment# Date Interest Principal  Balance action cannot be carried out on
10| 1 1/1/2018 _131.25  563.03 29,436.97 a merged cell.

| Car Payment | )

B S Rl Car Pi

Insert Page Layout Formulas Data i View Q Tell mewhaty Data View Q Tell me what you

o Cut Calibri ~11 < A A
ER Copy -

~ Format Painter 8 = =2

=¢ Wrap Text L ¢ Wrap Text

N

5
3= Merge & Cent

== ~ z
Alignm }l Merge 8 Center

c
12
I
(1|
1]
|II|

3

1]
1]
il

Merge & Center

Clipboard £ Font [ Alignment ™
A

ortization Schedule

o
(@)
O
m
m
@
I

E F Merge Across
_;:- Unmerge Cells
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" Print Headers/Footers

0O L& =

Car Pay

Size  Print Breaks Background\ Print

v Area ~ -

Page Setup

Page | Marginsl Header/Foote

7} Lrinter
Rows 1:6 now appear at the top of

page 2 and any subsequent pages that
get added if you expand the schedule.

Interest Rate 5.25%
Term 72
Principal 30,000.00

Payment (5486.63)

i ff-oibe '.>:r_l&_«-._ea~

.
oy 4\"-;..~Jkﬁ"":‘ By

to

Print area: |

Print One Sided

Only print on one side of...

Print titles y 4\
Rows to repeat at top%;\)

Collated

Columns to repeat at left: ! 2
=~ L0 a3 A~
}_“‘“_,—l‘\* o

123 123 123

Portrait Orientation
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Letter

\ Payment # Date 'Ly
42 6/1/2021
AR L

48 12/1/2021
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/"

Introduction to Find

B

hoose Find & Select >

on the Home menu are @
(or press Ctri-F).

in =~ p

E’ Delete ~

T Sort &\ Find &
(=] Forma *2 ~ " _Filter - Sglect
K | Lo b Replace.. :
= GoTo
Go Te Special
A B C

Find l Rep_lacel

Find what:

6

Options >>

Close I

Find All

A B c —
Pty L | nd and DI3 l

= Amortization Sche( 7 ) click the Options button to display
< these fields. Users sometimes forget
=
’

clicking either checkbox previously.
5.25%

Excel either activates the atch case

ithin: ISheet vl

/172018
Car Payment |

131.25

107 1
| -_*.- ]
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6 V - .
;| next cell that contains the L per— I~ Match entire cell conte
requested value...
8 ook in: IVaIues vl
<) Interest  Princ
48 3543 d(g —
. @ Use an asterisk as a
WHCCRELIOr PRIIAUmICRES.
Find I Replace | Find l Replac
Findwhat:  [1/1/21 FIRG what) S\ */ (2021
9 =
lick Find All to see all matches.
...or reports that the value Each match is a hyperlink. hd Al
couldn’t be found. Book Sheet Name | Cell
Car Payment.xlsx  Car Payment SBS46
W ldrit find what iGokinaTor. Click O Car Paymentxlsx  Car Payment SBS47
St olo S i A Car Payment.xlsx  Car Payment SBS48
2. {12 cellfs) found
9 of 28
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Introduction to Replace

o

B

C

Amor;ization Sch;dulé_

Car Payment |

Font
B

Click Undo ifit's
immediately apparent that
areplace has gone awry.

&

Amortization Schedulei

1
o &
o 3 |
ing~ & Inset + 2 - A 1 3
e 7 6
i7" Delete ~ D x _
e > Sort 87 Find &
B Format~ &~ Fier - elect 5
K I
- e T
Replace (Ctri+H) LU
Search fortext you'd like to change
L . <
Find lace l o
Find wha D
Replace with« A5 ) Pa_ste
4 Clipboard
Replace All ) Replace | Find Al G I
. : — = 2
| Car Payment ) 3 |

hfma
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) B C
1 1l 1/1/2018' 13125 s
1 2 2/1/2018 128.79 5
3 3/1/2018 12631 3
1 4 4/1/2018 12383 | | 5
1 5 5/1/2018 12133 | 5
1 6 6/1/2018 118.83 5
1 7 7/12018 11631 3
1 8 8/1/2018 113.78| | 5
1 9 912018 11124 | 5
1 10 10/1/2018 108.69 | | 5
2 1 11/1/2018  106.13 5
21 12| 12/1/2018 5
22 | _ 1/1/2019 10057 [ 7|5
-8 g 2/1/2019  98.37
o limit your exposure select a
range of cells first before you
initiate the Replace command.
28 | 19 7/1/2013  85.22
29 ' 20 8/1/2019  82.56
30 | 21 9/1/2019  79.88
31 \ 22 10/1/2019  77.19
l Car Payment )
10 of 28
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Trace Dependents

A B A | S W - G H
1 |Interest Rate 5.25% Interest Rate : Excel adds blue arrows to show the
2 |Term 72 Term cells that reference cell B3. Choose

3 lprincipal { 30,000.00 D |Principal : Remove Arrows on the Formulas
. ent :Payment B menu to erase the arrows.

elect any cell, no matter }p - ;
rnc

|
if filled or blank. Bayments  Date a
1/1/2018 131.25 355.38\29,644.62

2' 2/1/2018' 129.70 2/1/2018  129.70 356.94 29,287.68

3 3/1/2018  128.13 ; 3/1/2018  128.13 358.50 28,929.17
4 4/1/2018 126.57 0, 4/1/2018 126.57  360.07 28,569.11
| Car Payment ) | Car Payment ‘ *

A B . o E E G
6 Payment# Date g This prompt appears if a cell isn't

; resently referenced by any other cell.
Data  Review View Q1 |EM 1| 1/1/2018] ity aliseinuinle o

E 2 2/1/2018 £29,287.68
S 3 o~ Trace Precedents (%% /1 :
‘ ._ 7
+ -
Defined = - Trace Dependent !

) -
I8~ Names~ I'>. Remove Arrows ~ (/)

Car Paymentxlsx - Excel David Rin

The Trace Dependents command found no formulas that refer to the active cell,
Formula Auditing

t — ~
D | F | 6 | | D
| ———

orIToTo TEOTLEE TOUOTY TTyIINoY

: 9/1/2018 118.62  368.02 26,744.99
| Car Payment J )

hfma
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" Trace Precedents

| A | B | € | _ A
|Interest Rate 5.25%

‘Term ‘i\ 12

\Principa Select any cell that
payment | contains aformula.

2 (Term

3 |Principal
4 |Payment
5

Payment # Date

1 ilnieres& VRate

6 Payment#

D E F G

cells that C7 references. Choose
Remove Arrows on the Formulas
menu to erase the arrows.

w

Date terest Principal Balance

2/1/2018
3/1/2018
“ 4/1/2018
| Car Payment

W o SN Oy s W N

Data Review View

B o S e 5
T o |

- o T ts Vi
i Defined | "% Trace Dependents

> —
5~ Names~ I'>. Remove Arrows ~ (/)

' | Microsoft Excel

Formula Auditing

D | F | 6

: Car Payment ‘

The Trace Precedents command requires that the active cell contain a formula which Includes valid
references,

1/1/2018 A 131.25 355.38 29,644.62
2/1/2018 129.70 356.94 28,287.68
3/1/2018 128.13 358.50 28,929.17
4/1/2018 126.57  360.07 28,569.11
+)

“This prompt appears if a cell doesn't contain a
formula that references other worksheet cells.

1/1/2018
2/1/2018
3/1/2018

hfma
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>

| Car Payment | +
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Hom

hesaurus Check

Proofing
A

H ©-

O

e Insert Page Layout Formulas Data @ View
-- = | —

E@ Q E’;g |w:|

Accessibility Lookup

Spelling: English (United States) -'?_]2(_1

Interest Rat

Not in Dictionary:

Trem

Trem

Principle
|Payment

|Payment #

1
2
3
4,
5
6
7
8,,
9

hfma
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C Sugagestions:

1
2
3
4
5
2 o
¥

8

8/1/2
‘ Car Paym

Spell check complete, You're good to go!

Smart  Translate New

Comment

AFoc b

(' Show All C¢

Ignore Cnce

Ignore All |

Add to Dictionary I

Change All

AutoCorrect

Cancel

A

1,
2.
3
4

5

!
i

|

Interest Rat

Term
Principle

Payment S

10
11
12
13
14
15
16

($486.63)

Date

6/1/2018
7/1/2018
8/1/2018
9/1/2018
10/1/2018
11/1/2018
12/1/2018
1/1/2019
2/1/2019
3/1/2019
4/1/2019

Interest

123.41
121.82
120.22
118.62
117.01
115.39
113.77
112.14
110.50
108.85
107.20

] Car Payment |
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/
Text to Columns Feature - Addresses

A | Convert Text to Columns Wizard - Step1of3
7695 Moines, I1A 50301 \ The Text Wizard has determined that your data is Delimited.
Augusta, ME 04330 If this iIs correct, choose Next, or choose the data type that best describes your data.

‘-Original data type
Baton Rou—ge' LA 70801 C oose the file type that best describes your data:
Carson City, NV 83701 ited:

- Characters such as commas or tabs separate each field.
:Iefferson City, MO 65101 " Fixed width - Fields are aligned in columns with spaces between each field,
Martfort, CT 06101 /.

|}
1\ / )
eton Rouge, LA 70801

Select the data you wish <
Z arson City, NV 85701
to separate into columns. ‘ efferson City, MO &5101 -

s - Cancel ‘ Bac I _ Finish I

B

=
3]s Convert Text to Columns Wizard - Step 2 of 3 B _?_] ,Z‘_l

Au This screen lets you set the delimiters your data contains. You can see how your text is affected
in the preview below,
4 Delimiters
Cad | v 180

[ Semicolon [ Treat consecutive delimiters as one

Preview of selected data:

1 Pes Moines, IA 50301
- ME 04330

W0 NGB W R -

[y
o

Filter
Yo Advanced

Sort & Filter Data Tools Text qualifier: |' EI

D ‘ | F

W0 N G i B WK -

Cancel ‘

hfma
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/
Text to Columns Feature - Addresses

A ] B! | Convert Text to Columns Wizard - Step 1 of 3 Convert Text to Columns Wizar 21xl

Des Moines The Text Wizard has determined that your data is Delimif] |12 Screen lets you select each
~Column data format

Augusta If this is correct, choose Next, or choose the data typet (™ General

~Original data type , date values
BatonRouge Choose the file type that best describes your data:

Carson City |}/ NV 89701 [ - Characters such as commas or t
Jefferson City] MO 65101 {Fixed width)- Fields are aligned in columns
Hartfort

FFevlew of selected data;
1| Ia 50301

elect the data you wish 2 | ¥= 04330
3| 1a 70801

to separate into columns. s | wv 89701

s e y 5| ¥ ccant

Text To Columns Introductio Cancel |

This screen lets you set field widths {column breaks),
Lines with arrows signify a column break.

W 00N oy B W e

B g
L O

EDes Moines 1A
jAugusta ME
|Baton Rouge LA
Carson City NV
Jefferson City MO
|Hartfort CT

To CREATE a break line, click at the desired position,
To DELETE a break line, double click on the line,
To MOVE a break line, click and drag it.

Yo Advanced = « [ || [Data preview

Sort & Filter 3

E G 50301
) | | ) | 04330
70801
29701

W 00 N 6 ;s W

=
o

Cancel B L 2 | Text To Columns Introductio

hfma
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P
Flash Fill Introducti

on (Excel 2013+)

€ Undo Fiash Fill

Accept suggest

Select all 4 char

|';|

A B ey
[ ) 1 SSN 2
1 5SSN SSN 2 | 212681056 Flash fill options.
2 | 212681056212-68-1058 R e [
4 | 631715255 631-71-5255 r‘?g,
3 | 173841131 ) 5 | 267984412 267-98-4412
4 63{715255 6 | 301104556 301-10-4556
1 7|
5 , Type SSN and press Enter |8 |
6 3 to go to the next row. 9 |
1 Se— v 10 | ,, ,
Flash Fill - SSN | ) | Flash Fill - SSN

Salary Pivot Tablesxlsx - Excel

. A
1 SSN SSN
2 | 212681056 212-68-1056

i:£17384113 173
2

6317

Q Tell me what you want to do

Alternatively you
could type the first
SSNin cell B2
click Flash Fill on

i the Data menu.

Type the digit of the next SSN.
Excel will offer a list, press
Enter to fill the column.

hfma
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Data Tools

b Flash Fill (Ctri+E)

Bookl5 - Excel

at you want to do

Y

Filter

Bl

Flash Fill only works on
one column at a time. L

s ~ Al
2126810%&12—68-1056 2 |

173841131

z

Remove
Duplicates

ol

e hdhans

& <
1 ‘ Combined Name  First Last
2 |Mary Thompson  Mary Thompson
3 EBob Jones Bob Jones
B V’Mary-Alice Smith  Mary Smith
5 |Stacy Sommerville Stacy Sommerville
6 |Monica Woods Monica Woods

7 '!Josh Miller, JIr.

losh Jr.
8 |Denise Barnes DenisNarnes
Flash Fill sometimes
| misinterprets punctuated names.
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Introduction to Charts

c D A B (@ D

nuary February March
Apples 327 152 397
Oranges 466 449 370

=
o~

Fruit Sales |January February March
'Apples 327 192 397
'Oranges 466 449 370

Chart Title

February March

Select any cell within the
data you wish to chart.

The chart appears. g SRy
B Apples W Oranges

W 0 N O B W N

o= T RN - Y, RSV N

|
|

ey
o

Charts Introduction

hoose Column Charts Sl e c 2t
| 1 Fruut Salesljanua ' February March
from the Insert menu. ) . ry

VApples 327 192
|,, @@

Oranges | 466
2-D Column

f (R
g7 A8 4

Add a new month.

January February

W NG s WwN

Drag the Fill Handle to the right
to include the new data. =4

mApples W Oranges

(=]

hfma
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Slide ID: 2307

A B C D F G

Select any cell within the
data that you wish to chart.

| Apples vs. Oranges [

Charts - Saved

B

Tables

v

[llustrations

A
| Fruit llanuary February March
2 Apples 327 192 397
| Oranges 466 449

| Apples vs. Oranges [ ®

hfma
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| Fruit Salesl)anuary February March  April May
\Apples 327 192 397 464 500
' Oranges 466 449 370 385 432

Incart Chart More options appear here.

Recommended Charts

*  Clustered Column

Chart Title

March Apri| May

=
ouble-click to add arecommended
chart to your worksheet.

lanuary February

B Appies 8 Oranges

A clustered column chart is used to compare values across a few
categaries, Use it when the order of categories is not important.

Cancel
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 Conditional Formatting — Duplicates

Select the cells to

test for duplicates.

1871
11344
11334
11908
11760
11961
11318
11334
11766
11468
11173
11306
11905
11653

116@:

R V2T 00 SR Vo S 00 BRE Vo S 00 BUE Vo S 00 SRR Vo S 00 SRR Vo SIS 00 BRE o S 00 SRR Vo 8

. Duplicates |

hfma
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ormatas Cell
Table~ Styles~

E Top/Botic E.‘ Greater Than...

T
@l Data Bars E' Less Than...

-
Color Scal Between...

f— Equal To...
=] =3

B
Icon Sets

|
New Rule.., Ei H Text that Contains...

1o Clear Rules

1 X
@ MarisgeRule E'ﬁ A Date Occurring...

. A 0| B

' Invoice Numbers Total

’ 11760 90.03
11173 82.75
11105 77.63
11413 74.92
11871 83.29
11344 96.34
11334 61.27
11908 67.38
11760 61.66
11961 95.72
11318 69.41
11334 86.76
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Duplicate Values

Format cells that contain:

values with | Light Red Fill with Dark

Alternatively choose Unique.
e S——————————

Duplicates |
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Choose Conditional Formatting | X
on the Home Menu.

B
g Invoice Numbers Total
& Share @ 11760 $ 90.03
11105 77.63

E‘;_] [ D et~ D' 7_\7 ,O ] 11173 § 74.92

e &7 Delete
Conditional formatas Cell Sort & Find & 11871 83.29
96.34

ormatting/ Table~ Styles- [ Format~ | & > Eijers Select- 11344
l Cells Editing 11334 61.27
-1z Highlight Cells Rules ¥ | L M N 0 11908 67.38
' 11760 $ 61.66
Top/Bottom Rules 11961 95.72
11318 $ 69.41
86.76

72.88
69.90
68.37
54.60
63.27
57.74

LN

Data Bars : 11334
11766

11468
11173
11306
11505
11653

= | Color Scales

Icon Sets

ﬂew RU[E...
11660 54.92
Clear Rules ) \ Clear Rules fram Selected Cells =3

E] Manage Rules.., kCC!ear Rules from gnﬁre@
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Home Insert Page Layout Farmulas

Peiect any cell within the colmn [E] From Text/CSV [l‘_\ Recent Sources F'T‘lj 7] Queries & Connections
Dg, From Web E“ Existing Connections =

that you wish to sort. You do not Refresh

need to selectthe entire list ’ All =
unless it contains blank rows. You can sort on up to 64 levels.

'Apples b 0
9 Kiwi 9967 99670

10 |Bananas 8435420, < Delete Level  E[ Copy Level |
‘\ Fruit Sales | (+)

Column_ Sort On Order

Sort by ITotal Sales vl Cell Color | (o cell Color |+
Cell Color '
Font Color ws _
Conditional Formatting Icon __, Additional sorting

options appear here.

Queries & Connections
D

8

ou can sort various criteria.]

Queries & Connections Sort & Filt]

E F 9
Cases Sold Total Sales

6168| 61680| el

6079 85106 Fruit Sales
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/ |

“Initiating a Pivot Table

A C

iRegion y | IVendar

y Fruit R Us
1

JITUT O~ F

INorth GA Atlanta
|North GA Atlanta
|North GA Atlanta

;North GA Atlanta Bob's Fruit
10 [Narth GA_ Atlanta Rnh'c Eruit
Fruit Sales
—

FruitRUs
Bob's Fruit
Bob's Fruit

Page Layout

o

ecommended Table | lllustrations
PivotTables =

PivotTable

Tables
A B | c
1 |Region _lCity Vendor
2 |North GA Atlanta FruitRUs

~ | Fruit Sales

hfma

region

1
2 |North GA
3 |North GA
4 |North GA
5 |North GA
6 |North GA
7 |North GA
8 |North GA
9 |North GA
10 North GA
11 |North GA
12 |North GA
13 |North GA
14 North GA
15 |North GA
16 North GA
17 |North GA
18 |North GA
19 |North GA
20 North GA
21 |North GA
22 North GA

r A -
{Region _ICity

B | | B D
Vendor Product

Atlanta FruitR Us Oranges

E

6168

Create PivetTable

Choose the data that you want to analyze
(@ Select a table or range
'Fruit Sales'ISAS1:SFS51|

() Use an external data source

Table/Range:

Choase Connaction,,,
Connection name:
Use this workbook's Data Model
Choose where you want the PivotTable report to be placed
(® New Worksheet
() Existing Worksheet

Location:

Choose whether you want to analyze multiple tables

Add this data to the Data Modal

4) ok

X

Cancel

ATIant Urange u Graa Bananas
Atlanta Orange U Glad

Blue Ridge Mountain Fruit

| Fruit Sales &)

Mixed Berries
Oranges

731t
6227

6415

F

“CAases éol& ~TotéAI7 éélAes '

61630
85106
66638
75548
29540
93816
21910
99670
98420
89930
54263
107856
71747
126630
11557
72061
31260
43121
81521
93405

89810
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" Pivot Table Interfaces

&3]

he 'PivotTable Analyze' and 'Design’ tabs
and the Field List appear when you move
your cursor inside of the pivot table.
Refresh Change Data | Actions | Calculations
v Source g ¥

Data
D E F G

Your report will appear within this
blank pivot table canvas.

ivotTablel S

,! Turn on the PivotTable Field |
J List to work with the

1
2
3
4
5
6
7
8
9

If the PivotTable Field list isn't
onscreen, right-click on the pivot
table and choose Show Field List,

or choose Field List from the
Analyze (or Options) menu.

b b
- 0

Refresh

-
ra

PivetTable Options...

-
w

—
& |
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PivotTable Fields

; to add to report:

Use the PivotTable Field
list to add/remove fields
from your pivot table.

[] Vendor
[ ] Product
[] Cases Sold

Drag fields between areas below:

¥ Filters Il Columns

Defer Layout Update
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/
Adding Fieldg to a Pivot Table

(!; Product - L : X !
ot || PivotTable Fields ~ X 4) cases sold by product appears.

Drag fields i\ \Ween areas below: ‘ oo - -
|- Choose fields to add to report: 1 *
. \F |Row Labels | **Sum of Cases Sold

Filters Il Columns ; ‘
£ [Search |Apples

- |E jBananas
elect Product, which Excel S — Kiwi
. . | Froduc 1
places in the Rows section. 3 Cares SoMd _ ‘Mixed Berries
. - 18 (,: [] Total Sales Oranges
‘ ‘Grand Total

More Tables...

Drag fields between areas below:

One of each product from | f , T Filters Columns
the Fruit Sales list appears.

|Row
\Apples
‘Bananas
|Kiwi

'Mixed Berries
|Oranges
'Grand Total

Rows

Product

1]
2
3
4
5
6
7
8
9

—
5]

| Sheetl | FruitSales ... i ReatayoutUpaats
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| Sheetl

48236
63093
53671
43733
58854
267587

Fruit Sales ...
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| I Recommended PivetTables
Vendor
Fruit R Us Sum of Cases Sold by Re.. |~ Sum of Cases Sold by Region

1 SRS T Row Labels ~ Sum of Cases Sold

Select any cell within the list. Mid GA S6088 Mid GA 56038

< T : Ty North GA 173289 North GA 173289

e e - south GA 38210
:North GA Atlanta FruitR Us SR g R South GA 38210
_]North GA Atlanta Bob's Fruit Grand Total 267587

\North GA Atlanta  Bob's Fruit Sum of Total Sales by R..
\North GA Atlanta  Bob's Fruit 4)
10 [North GA Atlanta  Bob'sFruit A e : :

| Mid GA 691787 Select any suggestion as a starting

Fruit Sales ‘ ® North GA 2108437 - .
- sisil g point. You can add/remove fields from

Grand Total 3209638 the resulting pivot table as needed.

W 0 SN Oy o W

66638,
75548,

i
Page Layout Sum of Total Sales, Sum,., 29940:
33816

[ Row Labeds = S of Totsl Sales Sum of Cases Sol I
O Applas 612327 237 213 10|

Bamanms TIGLS 630 I
IHlustrations Kiwt a7 “36 939670,

ay 7 I
~ Mixed Berries 2183683 47
Oranpes 71977 g 98420:
Grand Total 3299039 W78 |
Tables 83330

54263!
A B Sum of Cases Sold by Pr... :
: 107856

1 |Region Clty R/en_dof v 71747
3 1

2 ;North GA |Atlanta ErafERis Blank PivotTable Chanage Source Data... Cancel
3 North GA Atlanta FruitR Us
hfma

region
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Password Protect the Workbook

Kl Save As X § Bl saveAs

2 B > ThisPC » Desktop Search Desktop - « 4 B8 > ThisPC > Desktop

General Options ?

Organize « New folder

Email attachmer * @ L] Atways create 9‘“"9"

MNetwork File sharing ’ 3
Favorites R

MiComputer Password to gpen: @

Public ; L.

A David Password to modify:
Shared favorites os&Homegroup

[[] read-only recommended

Sprint 7 Ly Libraries g

[ This PC
B 3D Objects il Save As

I Desktop . - v 4 B > ThisPC » Desktop

Confirm Password ? X

File name: | Employee Listxlsx

password to proceed.

Save as type: |Excel Workbook (*.xlsx) Map Network Drive..

Authors: i
WEb 0 tlons Caution: If you lose or forget the password, it cannot
G : be recovered, It is advisable to keep a list of passwords

. ' and their corresponding workbook and sheet names in
Tools appears elsewhere Compress Pictures.., a safe place, (Remember that passwords are

in the Save As dialog box case-sensitive.,)
in Excel 2007 and earlier.
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XE Open

=
|\ ) [ ~ Local ~ Microsoft ~ Office ~ UnsavedFiles > & | Saarch Unsavedries

Organize v  New folder

& L§: Microsoft Excel D

d.-| Book1{(Unsaved-305303883094888131)).xIsb  Microsoft Excel Bina...

» B3 Favorites | Book2{(Unsaved-305304181607614520)),xisb  Microsoft Excel Bina...
Protect T || Book1{(Unsaved-305306383689677913)).isb  Microsoft Excel Bina...
Warkbaok ~ . -] Book2((Unsaved-305308302630131204)).xisb  Microsoft Excel Bina...
|-| Book 1{{Unsaved-305309932553347118)).xlsb  Microsoft Excel Bina...

Book2((Unsaved-305310230667460907)),xlsb  Microsoft Excel Bina...

g ()] i Computer \
This button is labled Manage

Versions in Excel 2010/2013. | €& Network ‘ In Excel 2010 and later workbooks that you
: purposefully or accidentally closed without saving
linger in the UnsavedpFiles folder for a couple of
; , days before being automatically deleted.
Export g

] ¥y Homegroup

l |

Publish

- - File name: | Ll IAII Excel Files (* 1% xlsx* xlsm;
‘Recover Unsaved Workbooks

f)ﬂ Browse recent unsaved files Jools Open ]v Cancel
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Thank you for attending!

I'm happy to hear from you. In particular let me know if you did not
receive the handouts for this presentation.

David Ringstrom, CPA
L) ask@davidringstrom.com
] www.twitter.com/excelwriter
] www.linkedin.com/in/davidringstrom

Is there something you were hoping to learn today but didn't?
Please let me know. You can ask me anything about Excel.
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